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GETTING STARTED 

Included with your Media Vision product are two programs for recording, play 
back and mixing Sound files (both AIFF and FSSD file formats). The applica
tion's small file size and ease of use allow even a low-end Macintosh system 
and a moderately experienced computer user to enter the exciting world of mul
timedia. 

Sound Tools 16 can be used to record, playback, and edit Sound files. You can 
use these Sound files in presentations, HyperCard stacks or QuickTime files for 
exciting audiovisual entertainment. 
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System Requirements 
Your system must meet all ofthe following requirements in order to use Sound 
Tools 16 and the Mixer Control Panel. 

• You must be running either System 7.0 or later, or System 6.07. 

• Your Macintosh must have a minimum of 4 megabytes (ME) of RAM 
memory. 

• Your hard disk must have at least 2 megabytes (MB) of free space. 

Using Your Sound Tools 16 User's Guide 
The Sound Tools 16 User's Guide describes how to use the applications in
cluded with your Media Vision product and how this guide is organized. Refer 
to the "User's Guide Overview" section below for more information on what this 
application can do. This guide assumes that you have read and are familiar 
with the Owner's Guide that came with your Macintosh. You should know how 
to use the mouse, open applications and documents, and know how to navigate 
through folders with the use of the Finder. Refer to your Macintosh Owner's 
Guide for more information. 

User's Guide Overview 
This guide is divided into various sections. The following is a breakdown of the 
contents of this guide. 

• Getting Started: This section describes how to use the Sound Tools 16 
User's Guide and what it contains. The minimum system requirements 
are also described as well as how to begin using the Sound Tools 16 ap
plications. 

• Sound Tools 16: This program can record, edit and playback Sound files 
for use in your Macintosh applications. 

• Mixer Control Panel: Use the Mixer Control Panel to control up to five 
line-in devices (four Line-in and a microphone input). This Control 
Panel (CDEV) is ideally suited for work with Sound Tools 16 or any 
other recording application. 

• Glossary: Common Sound Tools 16-oriented definitions are covered at 
the end of this section (refer to page 19). 
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Assumptions 
This User's Guide assumes that the user is familiar with Macintosh class com
puters and has some exposure to the Macintosh graphical environment. 

Graphical User Interface (GUI) 
Sound Tools 16 uses a graphical user interface or GUI. A GUI emphasizes vis
ual presentation and is designed to mimic real-life tools or control panels (me
ters, scales, mixers, recording consoles, etc.). Many people find that these 
real-life associations make it easier to use software programs. Shown below are 
the Sound Tools 16 application and the Mixer Control Panel. 

L ________________________________ ._ 

Making Backup Copies 
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Your software is not copy-protected. Simply put, this means you are allowed to 
make a backup copy of your Sound Tools 16 software for yourself. A backup 
copy ensures that you'll be able to recover your original program if anything hap
pens to your hard disk or original software disk. 
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SOUND TOOLS 16 

This section provides a brief introduction to the basic features associated with 
Sound Tools 16. You can use Sound Tools 16 to create Sound files for your mul
timedia presentations or to annotate or add music and sound effects to Hyper
Card stacks or other Macintosh applications. You can also use the included 
Mixer Control Panel to mix different audio sources into your applications with 
Sound Tools 16 or any other application you want to use to record Sound files. 
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Sound Tools 16 Interface and Legend 

Sound Tools 16 Buttons (from left to right): 

Play: Click once to begin playing your sound file. 

Pause: Click once to pause the playback of a Sound file. 

Stop: Click once to stop the playback or recording of a 
Sound file. 

Record: Click once to begin recording a new Sound file. 

VU Meters (or Input Level Indicators): 

The top meter represents the output of the left channel 
and the bottom meter represents the output of the right 
channel. A mono channel appears in both meters. The 
levels are indicated with color. Blue means the signal is at 
a low level. red means the signal is at a good recording 
level [sometimes referred to as "Line-level"). Yellow signifies 
the signal level is too high and includes distortion. On a 
monochrome display. green. yellow. and red appear in 
varying shades of gray. 

Status Window: 

The status of Sound Tools 16 is displayed in this window. 
Status modes include Playing. Pause. Stop and Record. 
Note: 



Recording Sound Files 

Recording Sound Files 
When you want to record audio in a 16-bit format, you must consider the 
amount of disk storage space needed to store the sound file. A sound file re
corded at an 8-bit setting consumes half as much as the same Sound file re
corded at the 16-bit setting. Also, keep in mind that your Media Vision product 
is designed to playback and record at the 8 and 16-bit settings. Your original 
Macintosh equipment can only record and playback at the 8-bit setting. 

The following table shows typical recording rates and the file sizes for one sec
ond of audio. 

Channel Sample Size Frequency File Size 
(KHz) (8 es) 

Starting Sound Tools 16 
The instructions for installing your Sound Tools 16 and Mixer Control Panel 
(CDEV) are described in your Installation Guide. If you haven't already in
stalled your software, do it now (refer to your Installation Guide). If you have 
installed you software, then your applications are ready to use. All of the neces
sary program files and INITs are already in their correct folders. For more infor
mation on your Installation software refer to your Installation Guide. 

To open the Sound Tools 16 with Mixer Control Panel: 

1. Click on your Apple system logo in Menu bar and select 
Control Panels. 

2. Double-click on the Sound Tools 16 icon and the Mixer icon 
to activate the programs. Once activated, the Sound Tools 
16 menu selections appear in the Menu bar. Now both the 

Sound Tools 16 with Mixer Control Panel 
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Sound Tools 16 and the Mixer Control Panel are ready to 
use. 

Quitting Sound Tools 1 6 
To quit from Sound Tools 16: 

Select Quit from the File menu. If you have not saved your file, you will be 
prompted to do so now. 

To save another version of a Sound file: 

1. Make the changes you want in the new version. 
2. Choose Save As ... from the File menu. 
3. Type the name of the new version. 
4. Click Save. 

Playing a Sound File 
To playa Sound file: 

1. Select Open from the File menu. 
2. Select a Sound file from among your selections. 
3. Click on a Sound file and click on Open. The Sound file 

title appears in the Sound Tools 16's title bar. 
4. Click on the Play button to begin playing the Sound file. 

If the Sound file did not play, you may have accidentally selected a portion of 
the sound file, causing Sound Tools 16 to play only the portion selected, instead 
of the entire Sound file. A Play point appears across both the Sound file's view 
windows (if you are playing a stereo file, only one channel appears if the file is 

Play Point I" I I ~ f t 1 t 11 fa .. U14 b • II 
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I 
mono). The play point moves along the Sound file to show you the part ofthe 
sound that is currently playing. 



Zooming In and Out 

Zooming In and Out 
Use the Zoom slider to Zoom into or enlarge your view of your Sound file. The 
Zoom slider can zoom up or down in seven gradual steps. You can see the 

--- Zoom Slider 

~,.+ ~ .. HI -0+-- Left Audio Channel 

~ ,,+.~ 2" H I-it---- Right Audio Channel 

Sound File in more detail (Zoom in) by dragging the Zoom slider to the left. You 
can see more of the Sound file (Zoom out) by dragging to the right. 

Recording a Sound 
Sound Tools 16 allows you to record Sound files using two methods: 

• Adding a Sound file to an existing Sound file. 

• Creating a new Sound File. 

To Add a Sound file to an existing Sound file: 

1. Open an existing Sound file. 
2. Use the Zoom slider to find a place where you want to 

insert a new sound on the close-up view. 
3. Click in the Zoom-in view where you want to insert a 

sound. 
4. Click on the Record button to begin recording. Speak or play 

the new sound into your line-in source (e.g., microphone, 
CD audio player, etc.). 

5. Click on the Stop button to end the recording. 
If you are not happy with the new sound, you can follow the same steps to try 
again. 

Record 
Button 
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To Create a New Sound file: 

NOTE: These steps assume that you have a Line-in source pre-selected. 

1. Click on the Record button to begin recording. Speak or play 
the new sound into your line-in source (e.g., microphone, 
CD audio player, etc.). 

2. Click on the Stop button to stop recording. 
3. Click on the Play button to listen to the new sound file. 

If you are not happy with the new sound, you can follow the same steps to try 
again. 

Cutting or Clearing a Sound 
To remove any part of a Sound file, start by opening the Sound file you want to 
edit. Perform the following steps: 

1. To find the part of the waveform you want to remove in the 
Zoom in view, move or resize the view window as needed. 

2. Place the insertion point at the beginning of the section you 
want to remove. 

3. Click and drag to select the part of the waveform that 
represents the sound you want to remove. 

4. Press the backspace key or select Cut from the Edit menu. 

Recording with a Microphone 
When you position your microphone, place it in an area that won't be too noisy. 
You probably won't want to install it on your Mac's case, because ofthe associ
ated vibrations and noise from the fan. 

When you use Sound Tools 16 to make a recording, speak in your normal voice 
and hold the microphone 8 to 12 inches from your mouth. You might want to ex
periment with different distances. 

Selecting a Microphone 
You must designate which microphone you are going to use when making a re
cording using Sound Tools 16. If your Mac has an internal microphone this is 
the selected default. If your Mac does not have an internal microphone, no de
fault selection is made. In order to override the default setting, perform the fol
lowing steps: 

1. Select Control Panels from your Apple menu icon. 



Sound Tools 16 Commands 

2. Double-click on the Sound Control Panel and 
select the icon labeled PAS 16. Return to the desktop. 

3. Select Restart from the Special menu. 

Sound Tools 16 Commands 
This section provides descriptions of Sound Tools 16 commands. The com
mands are organized from left to right, as they appear in the Sound Tools 16 
Menu bar. 

File Menu 
New 
The New command displays a New file box. This file box lets you select the 
sample rate, 8 or 16-bit mode, mono or stereo. Clicking OK appends this infor
mation to the new file. Documents you had open before choosing New remain 
open but are covered by the new window. The current values you have selected 
for your Sound files are applied to the untitled window you create. 

Open ... 
The Open command retrieves a Sound file from disk. Choose Open from the 
File menu to open a Sound file. 

Close 
The Close command closes your active window. 

Save 
The Save command saves the Sound file in the active window to disk. Use this 
command to save Sound files as AIFF files. 

Save As ... 
The Save As ... command saves the Sound file in the active window to disk. Use 
this command to save Sound files as AIFF files. 

Use the Save As ... command to save a document with a different name, different 
file type, in different folder, or on a different disk. 

Revert to Saved 
The Revert to Saved command causes the current Sound file to revert to the last 
saved version. This feature is helpful when you accidentally edit a Sound file. 

Quit 
The Quit command allows you to properly exit from your application. If there 
is an open file, you will be prompted to save any changes. 

11 
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Edit Menu 
Undo 
The Undo command removes the effects of your last command. 

Cut 
The Cut command deletes a selection and puts it on the Clipboard, replacing the 
previous contents of the Clipboard. The Cut command is not dimmed when 
nothing is selected. 

Copy 
The Copy command copies the selection onto the Clipboard, replacing the pre
vious contents of the Clipboard. You can use this command to put a Sound file 
or a portion of a Sound file onto the Clipboard. The Copy command is dimmed 
when nothing is selected. 

Paste 
The Paste command inserts the contents of the Clipboard into the Sound file. 
You can choose Paste several times to paste several copies of the same informa
tion. 

Clear 
This command removes the currently selected portion of your Sound file or Clip
board. 

Select All 
This command selects the entire Sound file. 



Sound Tools 16 Commands 

Effects Menu 
Louder 
Each successive invocation of the Louder command increases the Sound file's 
loudness (or amplitude) by 20 percent. 

Softer 
Each successive invocation of the Softer command decreases the Sound file's 
loudness (or amplitude) by 20 percent. 

Fade Out 
This command gradually decreases the volume of the Sound file (from 100% to 
0%) until the volume reaches the 0% level. 

Fade In 
This command gradually increases the volume (from 0% to 100%) of the Sound 
file until the volume reaches the 100% level. 

13 



SOUND TOOLS 16 

NOTES 

14 



MIXER CONTROL PANEL 

This section provides an introduction to the basic features associated with the 
Sound Tools 16 Mixer Control Panel (or CDEV). The Sound Tools 16 Mixer Con
trol Panel can be used with other sound recording applications, such as Passport 
Design's TRAX. 

15 



MIXER CONTROL PANEL 

16 

Mixer Panel Controls 
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Loudness: 

Line -in Sliders: 

The Mixer has five Line-in 
connections. Adjust the volume of 
each source with the 
corresponding slider. Available 
inputs: Line-in 1 , Line-in 2, 
Line-In 3, Line-in 4 and microphone 
[MIC). 

VOLUME (Master): 
This knob controls the volume of 
the currently selected audio 
channel and also controls the 
audio output while you playback 
Sound files. 

BASS: 

This button boosts the lower bass frequencies 
This knob controls the 
volume of the lower 
frequencies of all 
audio sources. 

of combined audio sources. IEIBA"1iI 

Stereo Enhance: 
This feature makes sounds being played 
back richer and fuller. This effect is 
accomplished by phase shifting the left and 
right channels by a small degree. This 
results in a ·Spatial Separation." which 
makes mono sounds stereo, and stereo 
sounds more dynamic. 

Mute: 
Mutes all audio output. 

TREBLE: 
This knob controls the 
volume of the higher 
frequencies of all 
audio sources. 



Mixer Basics 
You can mix up to five sounds at one time with the Sound Tools 16 Mixer. 
There are basically two stages to mixing sounds: 

• Decide which audio source or file to record from. 

• Make Adjustments with the Mixer Line-ins and mix the sounds. 

~ \ I n=n ---- ~I ...... -==- ~~'? 
EIE:3!!i9§'9E!!1.-..;;;;;;3 

••• 0 0 

. . 

Controlling and Mixing Sound Sources 
Use the Mixer's Line-in sliders to control specific sound sources. For example, 
you can turn down the volume of your CD audio player or tape deck connected 
via one of your Line-in ports while, at the same time leaving or reducing the vol
ume on your microphone Line-in. 

Mixer Basics 
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Starting the Mixer 
To open the Mixer Control Panel: 

1. Click on your Apple logo on the Menu bar and select the 
Control Panels from the submenu. 

2. Double-click on the Mixer icon to activate the program. The 
Mixer appears on your desktop ready to use. 

To adjust or mix the volume for Line-in or MIC [microphone): 

• Move the corresponding vertical slider (Line-in or MIC)to the d~sired 
audio level. 

To save another version of a mixed sound file using Sound Tools 16: 

1. Make the changes you want in the new version. 
2. Choose Save As ... from the File menu. 
3. Type the name of the new version. 
4. Click Save. 

Quitting the Mixer 
To quit from the Mixer Control Panel: 

When you no longer need to use the Mixer Control Panel, you can close it by 
clicking the close box. 



GLOSSARY 

To use this guide effectively, you should be familiar with some basic computer 
software terminology. If you are a beginner to the Macintosh environment, refer 
to your Macintosh User's Guide. 
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Audio Interchange File Format (AIFF) 
A standard audio file format. AIFF is supported by many applications, includ
ing Alchemy and Sound Designer in addition to Sound Tools 16. 

Alert Sound 
The sound your Macintosh produces when certain software or hardware events 
occur. This sound is sometimes referred to as the "System Beep". 

Amplitude 
The height of a Sound file. The amplitude of a Sound is an indication of the 
strength or apparent loudness of a sound. 

Application 
A computer program used for a particular task or type of work. 

Application Icon 
A graphical representation of an application that is minimized. You can find ap
plication icons on the desktop. 

Bus 
A bus is a collection of wires or paths on which data travels from one compo
nent (disk drive or printer for example) to another. 

Choose 
Use the mouse to pick or highlight an item that starts a process or action within 
windows. 

Click 
Quickly press and release the mouse button. 

Clipping 
A Sound file is clipped when the overall amplitude (apparent loudness) exceeds 
Sound Tools quantization range. See Quantization. 

CPU 
The Central Processing Unit (CPU) is a microprocessing circuit that is the 
"brain" of the computer. As the word "Central" contained in its name suggests, 
the CPU is the center of most of the computer's activity. 



Decibel (dB) 
A standard unit of measurement for sound level differences. 

Desktop 
The desktop is actually the background screen in the Finder. This screen is 
called the desktop because it is used (at least metaphorically) like a physical 
desktop. Application icons reside inside of folders which sit on the desktop. 

Double-click 
To click the mouse button twice in quick succession. 

Downsampled Sound 
A sound which has been recorded at a high sampling rate and then downsam
pled (or converted) to a lower sampling rate, is said to be "Downs amp led". Use 
the downsampling feature when you want to reduce the amount of memory or 
hard disk space for a Sound file. 

Dragging 
To hold down the mouse button while you move the body of the mouse. Use 
the dragging technique to move objects (e.g., folders) around the Mac's screen. 

Finder 
The Finder uses graphical icons to represent applications, hard disks, floppy 
disks, disk folders and the trash can. 

Icon 
Icons represent running applications, groups, and items present on your desktop 
or within a folder. For example, a graphic of a pen with paper could represent a 
word processor application. 

Insertion Point 
The Insertion Point is like the cursor in a word processor. It is where pasted 
data will be placed or other data may be inserted depending on the operation. 
The Insertion Point appears as a vertical line and can be moved by clicking the 
mouse button any where inside Sound Tools 16 view window. 

Menu 
The menu items listed in a menu are commands. A command is an action that 
you want the application to perform. 

Decibel (dB) 
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Quantization 
Sound Tools 16 quantization feature restricts the amplitude (apparent loudness) 
of a Sound file. This feature aids in the reduction of clipping. See Clipping. 

Sample Rate 
The total number of intervals per second used to capture a sound when it is re
corded (or more specifically, digitized). 

Sampled Sound 
Sampled sounds are sounds which have been recorded in a digital format and 
saved on your system for playback through a sound card or sub-system. 

Scroll Bars 
Use scroll bars to scroll horizontally or vertically through a window. 

Select 
An item is selected when it is highlighted by clicking on it with a mouse. 

Title Bar 
The title bar is located at the top of a window. The title bar contains the pro
gram or document name. 

White Noise 
A sound that resembles static from your television or radio. White noise is also 
defined as a noise that has a constant tone. For example, the sound an air condi
tioner unit makes can be considered white noise. 
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